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The Canvas window is one of the most important windows in MoviePack.
Here the objects are processed with the help of additional functions and
windows. Basic functions such as Scale, Position and Rotate can be
carried out using the mouse and the results can be seen immediately. It
is possible to have several Canvas windows opened at the same time.
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Canvas Window

The Canvas window in MoviePack contains objects which are
manipulated and animated. As in a Windows word processing
program several documents can be opened at once in MoviePack.
Moreover, each Canvas can contain an unlimited number of objects.

Each Canvas contains a project, also
known as an animation, which
includes objects such as movie
clips or still images, transitions,
audio and effects.

The objects lie on top of each other
like layers.

Opening a Canvas/
Animation

u By clicking on the left icon in the standard icon bar an empty
Canvas will appear. A new Canvas can also be opened by
choosing New from the File menu.

Pre-made animations (’*.M3’) are also available:

u Choose the command Open from the File menu. 

In the dialog box search for the desired file, click it and then
click the Open button.You can also click the  Open File icon
on the standard icon bar.

If you have inserted
several objects onto
your Canvas, the
result on the Canvas
and in the Timeline
may look something
like this. The objects
are arranged on top
of each other and
overlap each other
according to the
sequence in the
Timeline.
Manual Tutorial Reference Effects
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Invisible work sur-

face in video

Canvas:
Visible work surface 

in video

Minimize, maximize 

or close Canvas
window

Scale menu:
Maximize/minimize 

Canvas

Active Object:
Surrounded by a bor-

der

Handles:
For scaling or rotating 

the object

Center Canvas

Interface: Entire work surface

The display 
pattern of invi-
sible surface 
can be altered
Canvas Window
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Scale Canvas It is possible to scale the Canvas.

u By clicking the minus magnifying
glass , the Canvas becomes
smaller. 

u Click the plus magnifying glass 
to enlarge the Canvas. The animation
remains unaffected.

u Click the middle bar between the
magnifying glasses to select different
ratios or Best Fit.

u View / Zoom also enables you to
change the size of the Canvas.

Setting up an Animation 

Under File / Animation Setup you will find five index cards or tabs. This
menu also appears with a right-click in the Canvas and then select the
Animation Setup command.

Changing Resolution Select the tab Page. Here you can choose from a large number of
formats or select your own values. 
Manual Tutorial Reference Effects
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Background ColorThis menu, obtained
by clicking the
Background Color button
in Animation Setup,
enables you to select
the background color
of the Canvas and of
the animation. To do
so you can use either
the sliders or the color wheel and chromaticity diagram.

I When saving your animation the selected background color
will also be saved.

TimeThis tab determines the number of frames per minute.

SchemesIf you have a setup which you may wish to use again save it under a
suitable name in Animation / Schemes.

ObjectsIn this tab the color of the border surrounding the active object is
selected. You can also determine whether or not the trajectory will be
shown.

GuidelinesThe guidelines are helpful for the exact positioning of the objects as
their position remains constant even when different objects are inserted.
These guidelines can be easily transferred into another animation as
their position is shown numerically.
Setting up an Animation
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Options

Under Tools / Options or with a right-click in the Canvas and then select
Options, tabs which contain additional important settings appear.

Page View Under the Page View tab the pattern of the Canvas background, which is
invisible in both the Preview and the completed animation, is selected.

Choose between dots, hatched or solid and determine the intensity.

The color and position of the Safe Zones can be determined as well as the
color of the Canvas borders.

General Here several basic
settings can be altered.
It is normally better to
maintain the default
settings.

If Apply zero values to effect
is activated, then
keyframes with a value
of 0 will be positioned
at the beginning and
end of an object.
Manual Tutorial Reference Effects
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Display QualityIn Canvas Renderer the renderer and the display quality of the Canvas can
be set. Draft and Highest are the two extreme settings.

File LocationsHere you can select the locations for captured files, temporary video
files, additional plug-ins and additional footage. More detailed
information can be found in the ’Reference - Project Management’
booklet.

File ManagementMemory
management
is determined
here.
Options
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Additional Functions The Canvas has several additional functions.

u A menu with check boxes
appears with a right-click
in the Canvas window.

You can now:

l Show the border around
the active object and
change its color as well
as the color of the
trajectory.

l Show trajectory.

l Insert two additional borders for Safe Zones which can help
to position texts.

l Insert rulers above and at the left-hand side and pull out as
many guidelines as you need from the rulers.

These five functions can also be accessed under View / Canvas, rulers and
guidelines can be found directly in the View menu.

Help with Positioning If the Canvas has been moved and you want to center it:

u Click the Center button . 

It is situated in the bottom right-hand corner of the Canvas window.
Manual Tutorial Reference Effects
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Mesh

AIST has developed the unique Adaptive Mesh Technology to ensure
that rendering of 3D deformations is optimized thanks to the adaptive
wire frame. On surface areas where the effect is strong, the wire frame
is more finely structured. On areas where there is no deformation the
wire frame is regular.

To show the wire frame on the Canvas, go to Tools / Options / Canvas Renderer.
Select the AIST-OpenGL renderer and under Configuration check Wire
Frame option.  
Mesh
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Processing Objects

Objects are the basic components of an animation and are placed on
top of each other on the Canvas like layers. The picture information of the
object positioned on the Canvas determines the outcome.

Inserting Objects u By double-clicking you can select an object from the Browser
or an Album. It is then inserted, at its original size, onto the
Canvas and is inserted into the topmost track in the Timeline
behind the Timeslider. However, if a track in the Timeline is
already activated the object is inserted there. If there is
already an object in this track, a new track is opened above.

alternatively:

u You can drag the object out of the Browser or an Album and
place it onto the Canvas or Timeline.

alternatively:

u Click the  Open icon in the standard icon bar.

Deleting Objects u Delete an active object from the Canvas using the Del key or
under Edit / Delete.

Copying Objects u The active object can be copied onto the clipboard either
using the shortcut Ctrl + C, or under Edit / Copy, or by clicking
on the  Copy icon in the standard icon bar.

Cutting Objects u To cut an object go to the Edit menu and select Cut or use
shortcut Ctrl + X.

Pasting Objects u Having copied or cut an object you can then paste it by
going to Edit / Paste, use shortcut Ctrl + V, or by clicking on the

 Paste icon.

Duplicating Objects u To duplicate go to the Edit menu and select Duplicate or shortcut
Ctrl + D.
Manual Tutorial Reference Effects
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Changing the HandlesEach active object in the default setting is always surrounded by a
border whose eight handles can have different meanings. A different
pointer appears depending on the function:

u A border with square handles appears by clicking the object.
The object is now activated and its size and proportions can
be changed.

u With a second click a border with round handles appears.
The object is activated and can be rotated.

I The object can only be edited if the Timeslider in the Timeline
is positioned on the object.

Undou The previous ten changes can be undone by going to Edit /
Undo or shortcut Ctrl + Z.

Redou The reverse is also possible by going to Edit / Redo or shortcut
Ctrl + Y. The changes that were undone are restored to their
original state.

Switching between Anima-
tions

If you have several animations opened in
MoviePack and they are arranged either on
top of or next to each other, you can
alternate between them by clicking on the
desired Canvas window.

u In the Window menu all available
windows are listed. The current Canvas
window is identified by a tick. Select the
desired window.

I�The new animation does not affect
the partitioning of the windows. The
Timeline, Timegraph, Canvas, and Effect Box are
all updated with the addition of the new
animation.

Opening AnimationsEach animation has its own Canvas window.
Processing Objects
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u You can open a new Canvas window under File / New or by
clicking on the New Animation icon  in the standard icon
bar.

u If you want to open an already saved animation go to File /
Open or click on the  Open icon.

Saving Animations u Animations can be saved under File / Save or by clicking the
Save icon .

Closing Animations u To close your animation you can click on the close icon in the
top right-hand corner or go to File / Close.

ï Please do not select Exit as this shuts down the entire
application.

Positioning using the Mouse 

As soon as a new object such as a movie clip, still image or titler is
inserted into your project, the Transformations icon is automatically shown
in the Effect Box.

In MoviePack, the position, size and form of the object can be changed
and the object can be rotated directly on the Canvas. By using the
Timeslider in the Timeline or Timegraph you can determine the point in time
of the change. If the object is changed on the Canvas the points in time
of these changes are documented by keyframes in the Timegraph.

Moving Objects u Position the mouse
on the object. The center
of the object is marked
by a green circle. By
keeping the mouse
button depressed you
can move the entire
object around the Canvas.
The pointer will look like
this. 
Manual Tutorial Reference Effects
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A line - in the default setting yellow - denotes the path from one position
to the next so that a trajectory emerges.

Motion CurveIf you want the object to cover a path, for example make it curve around
the center of the Canvas, the time must also be adjusted.

As a default setting the object is positioned in the center of the Canvas.
Now adjust the Timeslider in the Timeline or Timegraph using the triangle
at the top of the Timeslider.

Then go back to the Canvas, move the object and adjust the time once
more etc.

Changing Motion DirectionThe path the object takes can be tracked using the motion curve. On
each position that the object has been placed you will see small nodes.
These nodes correspond to the keyframes which have been set
analogically in the Timegraph. Your object now follows a motion curve
whose movement should be rounded rather than rough and uneven. The
nodes enable you to smooth your motion curve.

u Activate the object whose movement you would like to alter.
The motion curve is then displayed and the nodes appear as
dots in the color of the object border.

u When you place the mouse over one of the nodes the pointer
changes to a simple cross. By clicking on the node it
becomes white and can then be moved.

u Pull the node away from the object path. The object path now
looks like a curve which becomes bigger and bigger the
Positioning using the Mouse
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further the nodes are pulled away from the object path.
 

Inserting New Nodes u Click the object path while holding down the Ctrl key to insert
new nodes.

Determining a Curve u Place the mouse on a node and right-click. From the menu
Node Properties select one of the three types of curves. For the
Bezier style you have the additional choices of smooth or
symmetric.

I Cusp adds direction
pointers to the nodes so
that you are able to
determine the direction
from which the curve joins
the nodes or moves away
from them.

Activate object and click on one of 
the nodes on the object path.

Move nodes. New nodes make the curve 
smoother.
Manual Tutorial Reference Effects
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Deleting Nodes from the 
Canvas

Nodes on the Canvas can be deleted from the animation.

u Right-click activates the unwanted node and in the menu
which appears choose the Delete Node command.

Moving Center Pointu Activate the point in the middle of the object while at the
same time holding down the Ctrl key .

u Drag the center point outside the object. Between the center
point of the object and the object path a broken line
appears. The rotation center point has been moved. With
this point you can create more object paths.

 

u For example, trace the outline of the orbiting object with the
center point. The moving object follows while always
keeping the same distance.

I If the movement is to be identical, divide the object path
temporarily into two equal parts.

Relocating Object Pathu If you want to relocate the entire motion curve, go to a node,
hold down Alt and move the object path.

.

Select the object you want to move. 
While holding down Ctrl key click 
and drag the center point. The object 
remains in its original position.
From now on the motion behaviour 
will follow the ectopic center point.
Positioning using the Mouse
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Scaling Objects

u The active object should have a border with eight square
handles. If the handles are round, click the object again to
switch to square handles.

u Position the mouse over one of the square handles and the
pointer appears like this .

u Click the square handle and push the sides of the object
together or apart. By holding down the Ctrl key the aspect
ratio also changes.

u Using either side handle  the object can be stretched
and compressed. The height however remains constant.

I If the Ctrl key is held down while moving the object, these
limitations no longer apply. The object stretches in both
height and width.

Sizing an Object Under Object / Fit to you can restore the object to its original size or fit it
to the size of the Canvas.

The Scale Factor is shown in the Effect 
Box. The proportions remain the 
same.
The change in size is immediately 
visible on the Canvas and in the Pre-
view.

By holding down the Ctrl key, a 
non-proportional change occurs in 
addition to the size change. Aspect 
displays how big the distortion is.

Activate object so that it is framed by 
a border with square handles.The 
size of the object can now be chan-
ged by clicking and dragging on 
one of the square handles.
Manual Tutorial Reference Effects
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Rotating Objects

Rotating on the X and Y 
Axes

u Activate the object you want to rotate. A border with eight
handles surrounds the active object. If the handles are
square, click again to obtain round handles for rotation.

u Position the mouse on a handle. A rotation pointer will
appear .

I The rotations can be carried out to such an extent that the
reverse side of the object is visible.

Rotating on the Z Axis 

Activate the object ensuring that the 
border handles are round.

The object can be rotated on the X 
axis using the top and bottom hand-
les.

Using the side handles the object is 
rotated on the Y axis.

The object can be rotated on the 
Z axis using the corner handles.

Numerous full rotations are possible. You can combine rotations whiche-
ver way you wish. Simultaneously 
pressing the Ctrl key means you can 
rotate on all axes from each of the 
handles .
Rotating Objects
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Moving Rotation Center Rotation mode enables you to move the center around which the object
rotates.

u Click on rotation center while simultaneously pressing Ctrl
and the pointer will change to this . You can now move
the center.

Numerical Entry

Objects can be scaled and rotated by means other than the handles.

u In the Effect Box, click on the Transformations icon that is inserted
when each clip or still image is composited.

u A window appears with four tabs, Position, Scale, Rotate and
Center and Focus (Rotation center and perspective distortion).

Z rotation now takes place from a 
different center.

X and Y rotations take place around 
the corner point.
Manual Tutorial Reference Effects
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u Click the desired tab and a submenu will appear where
values can be numerically changed. 

Default SettingEach transformation is automatically applied to the full length of an
object. A default setting applies neutral values to the beginning and end
of an object. Here you will also find keyframes with neutral values. After
inserting just one single keyframe a smooth animation is created which
runs from the beginning of the object to the inserted keyframe value. At
the end of the object you will again find the default setting.

In the tab Position 
you can move the 
position of the 
object on the Can-
vas either with the 
joystick, wheels or 
in the numerical 
entry box. 

Scale determines 
the factor of the 
scale and Stretch 
determines the 
ratio of the sides. 
1 stands for the 
original ratio. 
Minus values 
make the object 
higher and narro-
wer while plus 
values make it 
wider.

In the Center tab 
the rotation center 
can be moved. 
The blue field 
represents the 
object. Focus 
determines the 
degree of the per-
spective distor-
tion. The lowest 
value 30, results 
in the biggest dis-
tortion.

The Rotate tab 
offers you a gra-
phic control in the 
form of a globe. 
The height howe-
ver remains con-
stant. Turn the 
globe to rotate on 
the X and Y axes 
while the yellow 
ball around the 
globe rotates the 
object on the Z 
axis. All values are 
also shown in input 
fields.
Numerical Entry
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If you change the motion behavior or an effect parameter on an object,
a new keyframe is added.

You can create an animation with just one keyframe. This means that
the parameters continually change their values. Starting from the first
keyframe it either increases or decreases the value of the second
keyframe. Specific information can be found in the ’Reference -
Timegraph’ booklet.

Switching Default Setting 
On/Off

If you do not want the two zero keyframes to be automatically set, under
Tools / Options / General deactivate Apply zero values to effect. The effect then
covers the entire object with an approximate medium.

Unifying MoviePack allows you to maintain all changes made to a value until the
end of an object or the next keyframe. This process is called unifying
keyfames.

u Adapt your object until it has the desired position, size or
effect setting.
To unify go to Options / Unify or shortcut Ctrl + U.
The chosen effect parameters are now standard from

End (Standard effect setting)At the center (Highest amplitude)After 12 frames
Manual Tutorial Reference Effects
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beginning to end of the object (see the ’Reference -
Timegraph’ booklet).  

I Further functions which can be used to influence changes
over time can be found in the the ’Refernce - Effect Box’
booklet.
Numerical Entry
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